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INTRODUCTION 

 

ASTER is a micro simulation model for indirect taxes developed at Leuven.  It has 

been inspired a lot by the SPIT-model (Simulation Program for Indirect Taxes) from 

the Institute for Fiscal Studies in London.  The main adjustments took place to model 

the Belgian structure of indirect taxes, to make the model more user friendly, and to 

construct a more elaborate evaluation model once a simulation has been run.  Due to a 

more restricted database we have been more limited than the SPIT-model in the 

estimation of behavioural parameters. 

 

The version which is presented here is only a first attempt to catch up with the rapid 

development of micro simulation models abroad.  It is by no means a final version.  

The behavioural parameters could be estimated better, the budget survey used gets out 

of date, the problem of grossing-up the figures to the national accounts data should be 

investigated and there are many interesting theoretical problems which deserve a 

closer look (equivalence scales, zero expenditures, durable expenditures, definition of 

the welfare concept etc.). 

 

The model is limited to simulation of changes in indirect taxes (value added, excise 

and ad valorem).  The acronym ASTER has no meaning.  Ex post it has been 

explained by one of the users as Analysis and Simulation of Taxes and Evaluation of 

Reforms. 

 

ASTER; M_ASTER; F_ASTER; E_ASTER: What’s in a name? 

 

The structure of the program is illustrated in figure 1.  A complete run consist of three 

consecutive steps. 

 

First the user has to define a reform: which indirect tax rates have to be changed? This 

is done in the first module: M_ASTER (the M stands for Modelling) 
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     STEP 1 
 
 
           DEFINE              M_ASTER 
       A REFORM      
 
 
 
 
     STEP 2 
 
       SIMULATION  
 
  
        Without      With      F_ASTER 
       behavioural                behavioural 
         reactions                    reactions 
 
 
    
     STEP 3 
 
 
 
 
 EVALUATION      E_ASTER 
 
 
 
 
 
 

Figure 1: Structure of the program 
 

The resulting change in consumer prices will probably affect expenditure behaviour 

and hence tax payments by the household.  The simulation of the new expenditure 

pattern and resulting tax payments for each individual household takes place in the 

second step: module F_ASTER (the F stands for Forecasting). 

 

Finally the E_ASTER module (the E of Evaluation) evaluates the reform.  It provides 

answers to questions such as: ‘What is the average gain or loss for all households?’, 
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‘Has inequality increased or decreased?’, ‘Do younger households lose more or less 

than older ones?’, etc... 

 

The three modules can be run separately.  The same reform (the result from 

M_ASTER) can be pushed through F_ASTER (the simulation) several times with 

different options.  And a given output of the simulation can be analysed by E_ASTER 

in different ways. 

 

How do I install ASTER? 
 

To install ASTER on your PC you first have to copy the different parts of the program 

from the installation diskette to the hard disk or a network drive of your PC.  Then it 

is possible to set up the ASTER-program as a part of the Program Manager within the 

MS Windows operating system. 

   

The ASTER program on the installation diskette consists of two parts: The first part 

contains all the programs that we developed and all the data files which are necessary.  

Some of the programs we developed are in Visual Basic, others are written in Fortran.  

All programs which require user input and which present results (the ‘user interface’ 

programs) are written in Visual Basic as this language uses the same presentation 

objects as the Windows operating system.  We believe that one of its main 

characteristics is a high degree of user friendliness.  Also MS Windows seems to be 

the most popular operating system nowadays.  The programs that do the calculations 

run in Fortran.  All these files can be installed in whichever directory you want, but is 

a directory with the name ASTER not the most obvious choice? 

 

The second part of the installation diskette contains files which are necessary to run a 

Visual Basic Program.  These files should be installed in the 

C:\WINDOWS\SYSTEM -directory.   

For economical reasons we compressed the files using the popular PKZIP-program 

so that all files of the first part are packed together in one file: ASTER_1.EXE and all 

files of the second part are packed in a file named ASTER_2.EXE.  These two files 

are so-called ‘self-extracting’ files: when you run them they will start to unpack 
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themselves in the directory where they are in.  (Look at the paragraph ‘How to start 

the program’ to find details on how to run a program in MS Windows) 

 

There are basically two ways you can install the ASTER program: either you simply 

run the installation program that is on the installation disk, or you do all the steps it 

needs one by one by yourself.  First we will describe the easiest way and a little 

variant of it.  Then we’ll explain the more complicated way.  However no matter 

which way you follow, you nearly always must add an extra line in the CONFIG.SYS 

of your system.  This file is in the C:\-directory and it can be changed using a normal 

text editor like e.g. the Notepad Editor.  When you see the contents of the 

CONFIG.SYS-file try to find the phrase ‘ANSI.SYS’.  This is the name of the driver 

we use to display the current state of the Fortran-part of the F_ASTER module.  If 

you don’t find it you must add the line ‘DEVICE=C:\DOS\ANSI.SYS’ at the bottom 

of the file.  People using WindowsNT should use the ANSI.SYS of DOS5, all others 

can use the ANSI.SYS which is the package itself.  The name of the driver must be 

preceded by the subdirectory where it is stored.  In most cases (with a standard 

installation of DOS) this is C:\DOS.  Then save this new CONFIG.SYS-file and 

reboot the system.   

 

The easiest way to install ASTER is to use the program INST_AST.BAT which is 

also on the diskette.  If you run this program then the programs will be installed in 

C:\ASTER and the system-files in C:\WINDOWS\SYSTEM.  To do this: 

1. Put the diskette in the A:-drive 

2. From the WINDOWS operating system. 

 Go with the file manager to drive A: 

 Click on INST_AST.BAT 

 OR From the DOS-operating system: 

 Type ‘A:’  

 Type ‘INST_AST.BAT’  

 

If you prefer another directory than C:\ASTER we advise that you first edit the 

INST_AST.BAT-file on the diskette: You can e.g. replace all occurrences of 

C:\ASTER with the name of the subdirectory you prefer.  Then run the 
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INST_AST.BAT-program the way it is described above in point 2.  If you use another 

name than ASTER, you should also change the directory name in the FASTER.PIF 

file  If your system files are not in the C:\WINDOWS\SYSTEM you should change 

this directory as well in the INST_AST.BAT file 

 

Instead of running the installation program of the diskette, you can also install 

ASTER in a more ‘manual’ way where you have all the control:  

1. Create a directory where you want to store the programs and data-files, e.g. 

C:\ASTER.  This can be done using the File Manager of the Windows operating 

system: Thereto use the Create Directory of the File menu after you positioned 

yourself on the root-directory of the C:-drive.  If you prefer another directory you 

have to correct the contents of the F_ASTER.PIF substituting the ‘C:\ASTER’-

string with the name of the directory you have chosen.   

2. Copy the ASTER_1.EXE file from the diskette to the directory you created in 

step 1.  This can also be done using the File Manager of the Windows operating 

system: Click on the icon of the A:-drive on the top of the screen, then press the 

left mouse button while your cursor is on the name ASTER_1.EXE, keep the 

button pressed down, and move the cursor to the icon of the C:-drive.  Be sure that 

you are still positioned on the root-directory of the C:-drive before you do the 

copying. 

3. Position yourself in the directory where you just have copied the ASTER_1.EXE 

program.  Then run that program.  That is very easy if you are still using the File 

manager.  You just can click two times on the name ASTER_1.EXE. 

4. Copy the ASTER_2.EXE file from the diskette to the C:\WINDOWS\SYSTEM 

directory. 

5. Position yourself in that directory and run the ASTER_2.EXE program 

 

Table 1 shows the files that are in the ASTER_1.EXE file, while table 2 shows the 

files which are in ASTER_2.EXE. 
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FILE NAME Description 
ASTER.EXE Visual Basic Program 
ASTER.INI File with the options for the Visual Basic Program 
FASTER.OPT Simulation options for the F_ASTER module 
EASTER.OPT Simulation options for the E_ASTER module 
KAR.ASC Household characteristics 
UITG96.ASC Expenditures 1996 
ASTER.ICO ASTER Icon 
PAR2.EST Price-coefficients, used in F_ASTER 
ENG1.EST Engelcurve parameters, used in F_ASTER 
PRE96.MAS Tax-rates for of the goods, used in M_ASTER 
FASTER.PIF Pif-file with the settings of the Fortran programs 
F_ASTER.EXE Fortran program of F_ASTER 
E_ASTER.EXE Fortran program of E_ASTER 

 Table 1: Program files and data files of ASTER 

     
FILE NAME 

CMDIALOG.VBX 
GRAPH.VBX 
MSOUTLIN.VBX 
SPIN.VBX 
THREED.VBX 
VBRUN300.DLL 

Table 2: Visual Basic System files of ASTER 

 

Now you can make an icon in the Program Manager to start the ASTER program.  

You can do this either by placing the ASTER program in a group which already exists 

(e.g. Main) or you can place the program in a separate, newly created group.  You can 

create a new group by clicking on the File option in the menu bar of the Program 

Manager.  Then you click on the first line - New - of the pull down menu.  The 

dialogue box of Figure 2 appears on the screen. 

 

    

 

 

 

 

Figure 2: Dialogue box to create a Program Group 
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You click on the radio button on the left of Program Group and then on the OK 

button.  You get the dialogue box titled Program Group Properties (Figure 3) where 

you can give a name to the newly created program group.  Type ‘A S T E R’ for 

instance, and then click on the OK button.  The newly created group appears in the 

Program Manager now and is active.  If you did not create a new group, the group 

Main is active.  We will now put the program in the active group. 

Figure 3: Dialogue box to assign properties to a Program Group 

 

Click again on the File option in the menu bar of the Program Manager and click 

again on the New option on the first line of the pull down menu.  The dialogue box of 

Figure 2 appears again but now you click on the radio button at the left of Program 

Item.  Click on the OK button and you get the dialogue box of Figure 4 in which you 

have to enter where you have installed the program for this icon. 

 

  

Figure 4: Dialogue box to append the ASTER program to its icon 

 

In the first line you type the name which will be appended at the icon.  We suggest 

‘ASTER’ but any choice is possible. 

On the second line you type ‘C:\ASTER\ASTER.EXE E’ as we suppose that you have 

installed the software in the directory ‘C:\ASTER’ of your hard disk and ‘E’ is one of 

the two choices for the language-parameter you can submit to the program.  The 
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alternative for the language-parameter is ‘N’. When you choose ‘E’ some names of 

goods, aggregates and some titles in reports will be in English while ‘N’ selects Dutch 

names.  The default value of this language-parameter is ‘E’.   

Finally on the third line you type ‘C:\ASTER’.  Click on the OK button and the 

ASTER program will appear as an icon.   

 

You are now ready to start the program.  However, before you do so we advise you to 

create first one or more directories like e.g. C:\ASTER\WORK.  When running 

ASTER you will be asked in which files and in which subdirectories you want to 

store the results of ASTER.  As you cannot create a new subdirectory from within 

ASTER - you can only select an existing one- you should do that before.  (An 

alternative is the use of another session with a program that can create directories at 

the same time as you are running ASTER E.g. you can have a session that runs the 

File Manager.).   

 

How do I start ASTER? 
 

The program can be started if you double click on the appropriate icon in The 

Windows Program Manager.  ASTER can also be started from the File Manager.  

Position yourself in the ASTER directory (this is the directory where the ASTER-

programs were installed)  and click on the ASTER.EXE-filename. 

A third way is with the use of the Run command of the File Manager.  After you 

positioned yourself in the ASTER directory call the Run command of the File menu.  

Then enter ‘ASTER’ followed by a space and the language parameter of your choice, 

e.g. ‘ASTER E’. Then click on the OK button or press Enter. 

 

The first time that you run ASTER it is possible that an error is generated due to some 

options of your operating system, more specifically the number format.  When an 

error message, like the one in figure 5, appears you must click on OK and then you 

have to change the number format of your system. 
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Figure 5: Error Message due to a wrong number Format of the o.s.  

 

To change the number format open the Main Program Group.  Then click 

successively on the Control Panel and on the International icon.  This will open a 

window with the title ‘International’.  In the corner at the bottom right the number 

format of your system is displayed.  If you received an error the number most likely 

will look like ‘1.234,22’ while the correct format is ‘1,234.22’.  To change the format 

to the correct format click on the change button next to the number.  Then the 

dialogue box  displayed in figure 6 will appear. 

 

Figure 6: Dialogue box to set the Number Format  

 

In figure 6 the correct format is displayed.  This means a comma for the 1000 

separator and a point for the decimal separator.  If your settings differ, do change 

them and click on the OK button.  Then you can start ASTER again. 

 

After you started the program a window pops up with information on how to contact 

the authors of the program. 
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Figure 7: The information  window of ASTER 

 

Click on OK or press Enter to come in the Main Window of the program from where 

you can start the different modules of the program.  To work with one of the three 

main modules click the File Menu and you get the pull down menu represented in 

Figure 8. 

 

 

Figure 8: The starting window of ASTER 

 

The menu offers three possibilities corresponding to starting up M_ASTER, 

F_ASTER or E_ASTER.  On your first use of the program, start with the M_ASTER 

option. 



  p. 11 

How do I Quit ASTER?    

How do I Quit ASTER? 
 

You can exit the program using one of the following methods when you are in the 

Starting Window of the ASTER program: 

1. You can select the Exit option of the File menu. 

2. You can double click on the Control menu box, which is on the upper left corner of 

the screen. 

3. It is possible to select the Close option of this Control menu. 

4. Finally you can also press ALT+F4.   
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M_ASTER: When do  I use It? 
 

The M_ASTER program is designed to calculate price changes resulting from a 

change in indirect tax rates: You can model (or define) a reform by changing the 

indirect tax rates of 747 items of goods and services.  You can select which tax rates 

you want to change by entering the new post reform tax rates.  The program will store 

the post reform tax rates in a different file with a user defined filename.  So 

essentially you define two series of prices (called pre- and post reform) and the 

difference between both can be considered as the effects of a proposed tax reform. 

 

Although it is possible to use a created post reform file as a new pre reform file in a 

next simulation (just fill in the name of such a post reform file) the main goal of this 

module is the creation of a file which holds this tax rate changes.  Such a file can then 

be used as the input for the F_ASTER module.  It is generated when you actually run 

the M_ASTER program: normally this is done after changing the prices.  So by 

creating and using different files as pre- and post reform you can generate different 

inputs for the simulation program.  The report functions of M_ASTER allows you to 

visualise the effects of the changed tax rates. 

 

How do I start M_ASTER? 
 

When M_ASTER is started there appears a dialogue box titled M_ASTER: Select 

Files.  We have reproduced it in figure 9.  The M_ASTER program is designed to 

calculate price changes resulting from a change in indirect tax rates.  The baseline 

situation is called Pre Reform.  The changed situation is called Post Reform.  The data 

for both  pre and post reform situations are kept in two separate files.  These files 

have exactly the same structure. 
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Figure 9: The Select Files window in M_ASTER 

 

The first time you start the program the system will suggest to use the file 

PRE96.MAS, located in the ASTER subdirectory (by default this is C:\ASTER).  This 

file contains the Belgian indirect taxes on the first of January 1996.  But you can use 

whichever file with the same structure as PRE96.MAS.  An example of such a  file is 

the file holding the post reform prices and taxes which is produced in the M_ASTER 

program.  E.g. you might create a uniform post reform tax rate for all goods with 

M_ASTER and then use that file in a next run as the input file.  You can then  

investigate the effects of raising that uniform rate with a certain percentage. 

  

If you know a filename by heart you can just overtype the name of the Pre Reform 

File.  The default extension for the files used in the M_ASTER Program is .MAS.  

Likewise the default extension for the files in the F_ASTER module is .FAS.  We 

advise to keep this convention as this makes it easy to recognise the files that can be 

used as pre Reform Files.  Instead of typing in the name of the file you can also use 

the Change Button at the right of each line.  This opens a standard dialogue box for 

choosing files within a displayed directory structure.  This is very handy when the file 

which you want to use already exists.  For more details we refer to the text under the 

header ‘How do I select a file?’ further in this manual. 

 

How are Commodities structured in M_ASTER? 
 

Figure 10 is the main window of the M_ASTER program.  It has three parts.  The 

upper part contains an option which is not operational yet and hence it is not 

explained here (a change has no effect). 

In the middle part of the screen you will introduce your changes of tax parameters.  

When it is first displayed, the left part of the screen shows a list (always in Dutch) of  

14 aggregates, each preceded by a plus sign.  These aggregates are the upper levels of 

the tree that is used to structure the 747 items.   
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Figure 10: M_ASTER main window  

 

The tree contains three levels.  The upper level consists of 14 aggregates.  Each 

aggregate can be unfolded by clicking the plus sign at the left of the aggregate.  E.g. 

the first aggregate ‘Voedsel (Food)’ can be unfolded into 9 items on the second level: 

‘Brood (Bread)’, ‘Vlees (Meat)’, ‘Vis (Fish)’, and six others.  There are in total 

33 items on this second level.  Except for the last group ‘N.E.G. (Not Classified 

Elsewhere)’ this second level corresponds to the structure of the matrix of price and 

total expenditure elasticities used in the F_ASTER program.  Deploying the 

aggregates one step further you find the 747 leaves of the tree.  E.g. ‘Vlees (Meat)’ 

can be unfolded into 41 different kinds of meat, among which chicken, steak, 

lambsmeat, etc.  These items at the third level are the individual commodities for 

which the respondents of the budget inquiry have recorded their expenditures and 

quantities.  Clicking on the plus sign changes it into a minus sign.  To close an 

aggregation you click on the minus sign. 

When there are more items in the list box than can be simultaneous displayed you can 

scroll through the list by clicking somewhere on the scroll bar, or by putting the 



  p. 15 

How do I select a Commodity in M_ASTER?    

mouse pointer on the upper or down arrow of the scroll bar and then keep the left 

mouse button pushed in. 

 

The very bottom of the window displays the total tax rate on the whole consumer 

budget in both the pre and post reform situation.  This tax rate is calculated by 

dividing the total amount of taxes by the total amount of expenditures.  In 1996 the 

Total Indirect Tax Rate equals 12.8%.   

The boxes with the information about the consumer price index are not operational 

yet. 

 

How do I select a Commodity in M_ASTER? 
 

Every item that is displayed in the left window of the M_ASTER main window can 

be selected.  It is not sufficient to scroll over the items in the list box by moving the 

cursor with the up or down arrow keys.  You really must move the mouse to an item 

and then click once with the left mouse button.  Then the name of the commodity will 

appear in the right part of the screen to the right of the word ‘commodity’.  Of course, 

to select an item that is on the third level you first have to go down to that level.  But 

it should be clear that elements on the three levels can be selected. 

 

How do I get Tax Information from M_ASTER? 
 

When an item is selected the tax rates for that item are shown.  The first row under the 

name of the commodity gives the VAT rate of the item, the second row the Excise 

rate and the third row shows the Ad Valorem rate.  In the fifth row the total tax rate is 

shown.  The fields in the left column present the pre reform situation while the middle 

column gives the post reform situation.  In the right column the difference between 

post-and pre reform situation is calculated. 

The fields on the right of ‘Expenditures’ show the amount of money spent on the 

commodity.  These are not the real figures of the budget survey but the figures of the 

survey multiplied by a factor such that they are in prices of January 1996.  The budget 

shares are displayed in the last row and are the true shares from budget survey.  
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Furthermore, both figures are means over all households, therefore sometimes 

unrealistic expenditures as 7 Bfr. will appear.   

 

The price of those products which have an excise in the pre reform situation is also 

shown.  This price is the consumer price.  The price is only shown on the third level.  

Except for the price, all information is available at all three levels of the tree structure. 

It should also be clear that on the first two levels the excises are expressed  

proportional to one, while on the third level values are expressed in Belgian francs.   

 

When we look e.g. at the taxes of ‘Voedsel (Food)’ we see that at the upper level the 

mean excise is only 0.001 %.  This is so low because there are only excises for 

‘koffiebonen (coffee-beans)’ and ‘oploskoffie (grind coffee)’.  When you go to the 

third level you can see that the respective amounts are 10 and 28 Bfr. 

 

How do I Change Tax Parameters in M_ASTER? 
 

Where do I make the Change? 

Most fields displaying information about the tax rates of a commodity have a light 

yellow background colour.  However, some of the fields have a white background 

colour.  These white boxes indicate the fields where you can enter new data.  This can 

be the post reform VAT Rate, the post reform Excise Duty and the post reform Ad 

Valorem Rate.  The difference between the post and pre reform value is calculated 

and displayed after you filled in a new value and pushed the Enter button or click on 

another item of the list. 

 

How do I change an excise duty? 

In changing tax rates we must make a distinction between changing the VAT rate and 

the Ad Valorem taxes on one hand and changing the excises on the other hand.  This 

is because the excise is expressed in Belgian francs per unit of the good.  This unit is 

e.g. one kilo for coffee or one litre for beer.  ASTER transforms the excise duty into a 

tax rate (i.e. the excise duty divided by the price).  Hence you need a price when there 
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is an excise for a product.  To change a post reform excise you must go down to the 

lowest level of the disaggregation.  If you change an already existing excise duty the 

pre reform consumer price is already available in the dataset.  So you don’t have to 

worry about consumer prices in that case.  But when you enter a post reform excise 

for a product that does not have a pre reform excise, you must provide the program 

with the consumer price in the pre reform situation.  Therefore you position the cursor 

on the price field and click Enter.  By default the consumer price has been set to 

1 Bef, which is a standard normalisation under the assumption of constant producer 

prices and has nothing to do with the observed market prices.  You can now enter a 

new pre reform price.  Keep in mind that you use a price for the same unit as the one 

on which the excise duty is based (e.g. if you introduce an excise for one kilo of 

bread, you should give the consumer price for a bread of one kilogram).  When you 

press Enter again the post reform price is displayed. 

 

For any other level than the one of the individual items, the excise box displays the 

tax after it has been transformed into a tax rate. 

 

How do I change a VAT or Ad Valorem rate? 

For the VAT and the Ad Valorem rate things are much easier.  You can introduce a 

new rate at any level of the aggregation.  Of course changing a tax rate of an item of 

the first or second level changes all tax rates of the items of the level beneath that 

belonging to it.   

 

Besides changing the VAT rates for each item separately M_ASTER has an option to 

change a post reform tax rate in a global manner.  Assume that you want to increase 

the VAT rate of 6% to 7%.  It would be a huge amount of work to look up all items 

with a pre reform rate of 0.06 and to change the rate to 0.07.  Instead you can use  the 

ReplacE Option of the Edit Menu.  Click this ReplacE option and you get the 

window of Figure 11. 

 

You can change the post reform tax rate on the base of the value of either a pre reform 

or a post reform tax rate.  Click on one of the radio buttons in the inner box.  At the 
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bottom of the window you enter the new tax rate.  When you have chosen the upper 

button Pre Reform VAT rate of  x% this means that the post reform VAT rates of all 

goods that have a pre reform VAT rate of x% will be changed.  This is a good way to 

undo the entered post reform VAT rates. 

 

 

 

 

 

 

 

 

 

 

Figure 11: The Window for a global change of VAT rates 

 

It is also a good tool to see the effects of a gradual increase of VAT rates of e.g. 6% to 

10% in steps of 0.5 %.  If you choose the second button (Post Reform Vat Rate of 

x%) things run differently.  Then the post reform VAT rates of all goods that have a 

post reform VAT-rate of x% will be changed.  Take the example where we first 

change the 6% rate into 20.5%.  But then we change our mind , and decide to replace 

20.5% again into 6%.  If you choose the second button for this, not only the goods 

which had 6% before the first step, but also all other commodities with a 20.5% rate 

will be set to 6%.  Note that it is always the post reform value which is changed, 

never the pre reform one.  The global change is put into effect by clicking the Replace 

option at the bottom.  Before you return to the main M_ASTER window a message 

box will appear with the number of items which have been affected by the change.  

Clicking on Cancel instead of Replace cancels the request of changing the values. 
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Why and how do I run M_ASTER? 
 

You can run the M_ASTER module by clicking on the Run menu.  This generates the 

input file for the simulation program F_ASTER.  This file will contain the pre- and 

post reform tax rates and consumer prices for the 32 commodity breakdown.  The pre- 

and post reform prices are put together to be used later on in the F_ASTER program.   

 

The name of the file can be chosen in the window which appears immediately after 

you have clicked on the Run menu (which is in the title bar of the ASTER window).  

The resulting window, with ‘Run: Generate F_ASTER File’ in the title bar, is a 

general purpose dialogue box that is used everywhere in Windows-programs to select 

a file.  We refer to the paragraph on selecting files - ’How do I select a File?’ - further 

in this manual for more details about this mechanism.  In the window you can enter or 

select the name of the file which transfers the tax and price information to the 

F_ASTER module.  The default extension for these files is .FAS.  As explained above 

the default path and name are the same as those of the post reform M_ASTER file. 

 

How do I get a Report of the Changes in M_ASTER? 
 

After changing some tax rates it may be interesting to see an overview of these 

changes.  This can be obtained by clicking on the Report option in the menu bar of 

the ASTER window.  You get a window like in figure 12. 

  

  

  

 

 

 

 

 

Figure 12: 

M_ASTER: the Report Window. 
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In all modules of ASTER it is possible to see the results displayed in both a text mode 

showing the exact numbers in a tabular format or in a more graphical way.  Both 

modes can be printed as you can print out all screens. 

 

To see the summary of what you have changed to the tax structure in the M_ASTER 

program you can click on one of the four buttons at the bottom of the Report window.  

By clicking on the Show button you get a summary table showing aggregate name, 

pre reform rate, post reform rate and the difference between both values.  These 

values are all expressed in percentage changes.  You will get 14 or 33 aggregates 

depending on which level of aggregation you select in the upper left part of the 

Report Window.  Indicate which kind of tax rate you want to see by selecting the 

appropriate rate in the upper right part of this window.  It is clear that by combining 

these choices 8 different summary tables can be generated.  For information on how 

to print these tables we refer to the description of the general reporting facilities 

below (See section: ‘How do I make a Report in Text Mode?’). 

 

In M_ASTER we offer three different ways to display the differences in tax structure 

among the aggregates graphically.  By clicking on the Graph Pre button the pre 

reform values of the selected tax in the right column is displayed.  The post reform tax 

rates of the aggregates can be obtained by clicking on the Graph Post tax rate while 

both pre- and post rates are shown when you click on Graph.  In all presentations the 

type of  graph can be chosen, as is also explained further on in this text below (See 

section: ‘How do I make a Report in Graphical Mode?’). 

 

How do I quit M_ASTER? 
 

To close the M_ASTER window double click on the upper left corner of the 

M_ASTER window or click on the Close option of the File menu of the M_ASTER 

window.  Be careful not to close the window of the main ASTER window, the title 

bar of which is above the M_ASTER window.  If you have made changes to the data 

you get the standard dialogue box to define the filename under which you want to 

save the changed post reform situation.  The file with the pre reform information is 
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never changed.  (Unless you used the name of the pre reform file as the post reform 

file in the dialogue box when starting M_ASTER, cf. figure 9).  But in a later run of 

M_ASTER you can load the file you have now saved as post reform, as the pre 

reform situation. 
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F_ASTER: What does it do? 
 

The F_ASTER program simulates the new expenditure pattern and resulting tax 

payments for each individual household based on the changes in consumer prices as 

defined in M_ASTER.  So the main information source is a file with tax and price 

information resulting from the reform defined in M_ASTER.  When F_ASTER has 

run the effects can be seen for every household as well as on a summary level.  The 

user can change the value of five parameters of the simulation process. 

How do I start F_ASTER? 
 
To start the F_ASTER program click on the File option in the menu bar of the main 

ASTER Window.  Choose the second line of the pull down menu: Open F_ASTER 

file...  You get the dialogue window shown in Figure 13 which allows you to define a 

set of input and output files.  It also allows you to set the simulation options. 

 

 

Figure 13: F_ASTER Main Window 
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How do I define the input Files in F_ASTER? 
 

The first line defines the file with the tax and price information, resulting from the 

reform defined in M_ASTER.  By default the last generated .FAS file is displayed 

here.  If you want to choose another name, either enter the name directly on the line, 

or click the Change button.  You can select a file in the standard dialogue box with 

directory structure and file names.  On the next four lines the names of the files 

holding Price coefficients, Engelcurve parameters, household expenditures and 

household characteristics can be defined.  If you installed ASTER in the standard way 

these files can be found in the C:\ASTER directory.  For the moment no alternative 

sets of parameters are available.  We strongly discourage  the user from changing 

these files with a text editor or any other editing tool. 

 

How do I define the output Files for F_ASTER? 
 

The output files are generated in the same directory as the file which holds the pre- 

and post reform taxes.  This is also the directory that is specified in the upper line of 

the F_ASTER Main Window.  This facilitates the grouping of all files which are 

involved in a particular run of the whole ASTER program.  F_ASTER can produce a 

maximum of 9 output files.  All these files have the same name but a different 

extension.  This name can be specified in the window to the left of the prompt ‘Name’ 

under the title ‘Output File Households’.  (In the example of Figure 13 this name is 

‘MY.’).  Be careful to enter only valid filenames as there is no validity check that the 

name you enter conforms to the naming conventions of  the operating system of your 

PC.  (Do not use spaces e.g.) 

 

F_ASTER always produces at least two output files.  The first is the Summary 

Statistic Output file with the extension .SSO.  This file holds the main simulation 

results.  The second file contains the information about total tax payments for every 

household in the sample.  Its extension .TPO stands for Tax Payments Output.  It is 

this file which will be transferred to the third module, E_ASTER, to assess the 

distributional impact of the reform. 
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The output of the 7 files holding household information is controlled by the user: 

when the corresponding fields to the left of the described output files (used file-

extensions are between brackets) are marked the files will be generated.  You are not  

able to see all possible results if you don’t select all options.  On the other hand, if 

you do not select any option, the simulation program still will run and it will be 

possible to see the main simulation results as these results are stored in the .SSO file.  

It is worthwhile noticing that when you select all options and you choose the 

maximum number of households, you need about 10 Mbytes free diskspace (which 

you can of course delete after you have seen the results). 

 

The first .DEX file holds the Detailed EXpenditures for every household in the 

sample.  It has the same structure as UITG96.ASC, the file we provide with 

expenditure data.  Hence this generated .DEX file can be used as the input file for 

Household Expenditures in a next simulation run of F_ASTER.  The exact format of 

the .UITG96.ASC file and a DEX-file is: On the first line there is an indication of the 

type of the file.  The subsequent lines contain first a ‘*’-sign, then the household 

number (6 positions) and finally the values for each commodity, 7 positions each.   

 

The file with the .DQT extension keeps information about Detailed Quantities while 

the .DSH-file holds Detail Share data for every household in the simulation.  The last 

four files .DTA, .DVT, .DEC and .DAV hold information about the Detailed Total 

Taxes, the Detailed VAT Taxes, the Detailed Excises and the Detailed Ad Valorem 

taxes for every household in the F_ASTER simulation run.  The format of the data is 

similar for all these files.  Every line starts with an ‘*’, then there is the household 

number (6 positions) and then there are the 32 pre reform values (one for every 

commodity) followed by the 32  post reform values (one for every commodity).  The 

length of each reform value is always 8, except for the file with the detailed Shares 

(.DSH) where it is only 5 long.   

 

All this information, when selected before the simulation runs, can be seen in one of 

the reports.  It is also possible to analyse these files with standard statistical programs 

like SAS or to use the results in Excell or other spreadsheets. 
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How do I change the Options for a Simulation in F_ASTER? 
 

There are 5 different options the user can select before he runs the program and which 

influence the outcome of the simulation. 

 

How do I change the Sample Size? 

You can determine how many households the simulation will use.  Type the number 

of households in the left field at the bottom of the F_ASTER Main Window or 

increase or decrease the number by clicking on the corresponding sign on the left of 

the indicated number.  You can also select the maximum number of households (this 

is 3235) by clicking on the Max button.  This maximum number will also appear if 

you type a larger number than this allowed maximum.  The minimum number of 

households for a simulation is 10.  Normally you will simulate with the complete 

sample, but the option can be interesting to shorten run time during test simulations.  

The choice of the households if you enter a figure smaller than 3235 is sequential, not 

random, nor based on household characteristics.  If you work with a test sample of 

100 households several times, the sample will always contain the same 100 

households. 

 

How do I keep Money or Real Income constant? 

You have the choice between keeping Money or Real Income constant.  If you choose 

to hold real income constant, nominal expenditures are adjusted for price changes as 

computed by a price index.   

 

How do I correct if the predicted Budgetshare is negative? 

Nothing prevents our behavioural model to produce negative budget shares.  If you do 

not like this, choose the option Correction.  A negative share is then set to zero, and 

all other shares are adjusted proportionally to keep adding up of the budget constraint 

satisfied. 
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How do I keep Zero Expenditures on zero? 

Due to the fairly disaggregated structure of the demand system, there are many zero 

expenditures in the survey.  It is a topic for future research how one should deal with 

the zeros during simulation.  Waiting for satisfactory results of this research, we have 

solved the problem in a pragmatic way.  Either the zeroes are fixed on zero and there 

is a proportional adjustment in the other budgetshares.  This is the option Keep on 

zero.   

Or you choose not to intervene in the simulation if pre reform zero expenditures turn 

into non-zero values during simulation.  This is the option Don’t. 

 

How do I choose the Behavioural reactions? 

Here you have three possibilities.  The first option is Normal which means normal 

behavioural reactions.  The simulation then uses the price and total expenditures 

elasticities from the estimated demand system. 

 

The option No (Cst Quantities) stands for no behavioural reactions and Constant 

quantities.  This means that all price and total expenditures elasticities are assumed to 

be zero.  Since prices have been changed and quantities are kept constant this implies 

that nominal expenditures have to be adjusted.  New prices are multiplied by old 

quantities to compute the new total expenditures.  This might conflict with what you 

have chosen under the Money Income held constant-option.  The latter option will be 

neglected when constant quantities is selected. 

The third choice Cst Budget Shares lets the simulation work with the assumption that 

all total expenditure elasticities equal one, all own price elasticities equal minus one 

and all cross price elasticities equal zero.  This produces effects on the quantities so 

that the budget shares remain unaffected. 

 

There are two more options on the screen which do not (yet) influence the program. 
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Can I adjust Budget Survey Expenditures to National Accounts 
Aggregates? 

One of the main topics for future research is the study of grossing up the data of the 

budget survey to the national level.  Choosing Yes, Do Adjust gives the impression 

that you could do this task now already.  But the data and procedures to gross up the 

figures in a reliable way are not available yet.  So whichever option you choose, the 

effect will be the same.  So we advise you to select the No option as this corresponds 

to what is really happening. 

 

Can I use another Demand System? 

In future versions of ASTER we intend to provide other demand systems.  For the 

moment there is only one and this demand system is always used, whichever option 

you indicate. 

 

How do I run F_ASTER? 
 

You can start the actual simulation program by clicking on the Run Menu.  The 

program then asks for a title as you can see in Figure 14. 

 

  

Figure 14: F_ASTER Simulation Title 
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When you have finished typing the title click on Ok and the simulation program will 

start running.  This brings up a screen like the one in figure 15a.  This screen looks 

slightly different from the windows seen so far as it is not a Visual Basic window but 

an output screen of the Fortran program that was called to perform the simulation.  

During the run of the simulation program the title of the simulation is displayed on a 

green background, as well as the progression of the program.  If you have a black 

instead of a green background, you probably did not install the ansi.sys correctly.  

(see p.4) 

  Figure 15a: F_ASTER Fortan Output Screen during the Run 

 

When all households (this is the number you indicated) are processed, the program 

clears the screen and changes the background colour to blue.  As shown in figure 15b 

a message and the start and stop time of the simulation program is displayed.  Of 

course the time it takes to complete the simulation depends on the number of 

households you have selected and on the type of computer you use. 

 

You can proceed with the program by pressing the Enter key.  This closes the 

Fortran-output screen and returns control to the Visual Basic program again.  You 

then are ready to look at the results of the simulation. 

 

The input-files and the options that have been used for the run are saved in the file 

FASTER.OPT 
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  Figure 15b: F_ASTER Fortan Output Screen at the End of the Run 

 

How do I get a Report of the F_ASTER Output? 
 

The Report-menu of F_ASTER has several options.  When you click on Report you 

can choose to see the results of the simulations done so far with F_ASTER (option 

Results) as well as to see information of the parameters that have been used (Engel-

curve parameters, total expenditures elasticities, price Coefficients and price 

elasticities) 

 

How do I view the Engelcurve Parameters? 

The Engelcurves are specified with a linear and a quadratic term in the log of real 

expenditures, denoted respectively by   and .  They have been estimated for four 

different subgroups of the households, depending on whether there is a smoker in the 

household and whether the household has at least one car.  It is possible to view the 

values of the  and  parameters of the file that was specified on the third line of the 

F_ASTER main window as the Input File for the Engelcurve parameters.  In figure 16 

we show the  -parameter values for all 32 commodities by subgroup, and a weighted 

average in the last column.  The layout of the results for the -parameters are alike. 
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How do I view Total Expenditures Elasticities? 

Although the simulation program uses the  - and -parameters, the user might be 

more interested in the implied total expenditure elasticities.  These elasticities are 

computed with the weighted mean budget shares of each subgroup in the budget 

survey inquiry of 1987-1988.  Once again this is done for the 32 aggregates in 

function of the four possible combinations of the two household characteristics.  

Figure 17, which shows these values, can be obtained by clicking on the option Total 

Expenditure Elasticities of the pull-down menu of Report.   

 

 

Figure 16: Beta Engelcurve Parameter as calculated from ENG1.EST 
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Figure 17: Total Expenditure Elasticities as calculated from ENG1.EST 

 

How do I view the Price Coefficients? 

A third series of values that can be displayed on the basis of an input file of ASTER 

are the price coefficients.  These are the -parameters of the QUAIDS specification.  

When you click on the option Price Coefficients of the pull-down menu of Report the 

dialogue box as displayed in figure 18 appears. 
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Figure 18: Dialogue window to select aggregates for showing price-coefficients 

 

The dialogue window of figure 18 basically consists of two parts.  In both parts all 

aggregates are displayed, preceded by a selection button.  In the lowest part there are 

two extra selections: Diagonal and all.  To see the effect of a price change of one 

aggregate on the demand for one or more aggregates click on an aggregate in the 

upper part of the window and on an aggregate in the lower half.  E.g. you can click on 

‘Bread’ in the upper half and on ‘Meat’ in the lower part to see the effect of a price 

change of bread on the demand for meat.  To actually see the value of that price-

coefficient click on the Show button. 

To see the effect of a price change of one aggregate on the demand for all other 

aggregates you must select ALL instead of one particular aggregate in the lowest part 

of the window.  When you click on Show a report, like the one in figure 19, will be 

displayed.  Instead of clicking the Show button you can also click on the Graph 

button.  Then you will see a graph of these price-coefficients.  An example of such a 

graph can be seen in figure 20. 
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Figure 19: Effect of a price change of one aggregate on the demand for the others 

Figure 20: Graph of a price change of one aggregate on the demand for the others 
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A third possibility is the report of the diagonal price-coefficients.  This can be 

obtained by clicking on Diagonal and subsequently on the Show button or on the 

Graph button. 

 

How do I view Price elasticities? 

The same mechanism as described above (How do I view price coefficients?) is used 

to show the price elasticities between aggregates: You first get a selection window 

with the same possibilities as above and after you have made your selection a table or 

graph is displayed.  The price elasticity not only depends on the parameter  but also 

on the expenditure elasticity.  Therefore price elasticities are calculated for the four 

subgroups (smokers, non smokers, car owners and non car owners).   

 

How do I view the Results of the simulation? 

Whereas the former reports were based on the values of input-files, clicking on the 

option Results of the pull-down menu of Report gives you information of a 

simulation you have run.  This means that contrary to the already explained reports 

you first have to run a simulation before you can see these results.  A second 

important remark is that it is not always possible to see all possible results as that 

depends on what you have selected as output files.  It is obvious that only those 

results can be displayed that are selected by putting a cross before their name in the 

‘Output File Household’-section of the F_ASTER main window.  (see the section on 

‘How do I define the output-files for F_ASTER?’).  Of course you cannot get 

information about a household that did not take part in the simulation because you 

limited the number of households for the simulation.  But it is always possible to get 

all information on the aggregates. 

 

Clicking on Reports results in a window like the one in figure 21 being displayed.  In 

the title of the window the file name which was chosen for the output files is shown.  

In this window you can indicate which results of the simulation you want to see. 

A selection in the upper part - if possible - shows information about the household 

whose number is displayed on top of that window.  You can change this number by 
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clicking on the up-arrow or down-arrow or by typing in a number.  It is obvious that 

this number cannot be bigger than the number of households involved in the 

simulation. 

 

  

  

   

 

 

 

 

 

 

 

 

 

Figure 21: F_ASTER Simulation Reports 

 

Figure 22 e.g. shows the total expenditures and taxes for the eleventh household of 

the simulation.  This is the household with the number 1681.  This selection of Total 

Expend and Taxes results in a report that gives a.o. information on the total 

expenditures and taxes which that particular household is supposed to spend in pre- 

and post reform under the specified conditions of the simulation.  The Total 

Expenditures and the first four Tax figures are again in Belgian francs of January 

1996.  The second table of the report situates the household on 18 variables.  Among 

these are e.g. ‘Leeftijd gezinshoofd (Age head of the family)’, ‘Aantal auto’s 

(Number of cars)’ and ‘Roker/Niet Roker (Smoker/ Non Smoker)’.   

 

The other reports on households give a more detailed picture of the different taxes, 

expenditures, quantities,  and shares for the 32 commodities. 

 

 



  p. 36 

How do I get a Report of the F_ASTER Output?    

 

 

Figure 22: Total Expenditures & Taxes for a particular household in F_ASTER 

 

The information on the aggregates can be seen after the selection of an alternative in 

the lower part of the Report window of figure 21.  A summary of the simulation is 

reported after clicking on the Show button when Summary has been selected first.  In 

fact this is the default option as it gives a report about the files and options that were 

used in the simulation, as well as an overview of the main results of the simulation.  

An example of a  possible summary of a F_ASTER simulation is shown in figure 23.  

This report shows the date and time of the simulation, the title, the number of 

households used and the options and files used in the simulation.  In the second half 

of the report the pre- and post reform values of the total expenditures and the total 

amount of taxes are shown in prices of January 1996.  Two tax rates, computed over 

all aggregates, the Stone Price Index and the real total expenditures are also displayed 

in this screen.  All this information is calculated from the file with the .SSO 

extension. 

The other reports on aggregates give a more detailed picture of the pre- and post 

reform values of taxes, expenditures, quantities, prices and shares for all 32 
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commodities.  The difference between the post- and the pre reform value is also 

shown, as well as the percentage change. 

 

 

Figure 23: F_ASTER: Summary Report  

How do I quit F_ASTER? 
 

The F_ASTER module can be closed in the same way as the M_ASTER module was 

closed: you can double click at the upper left corner of the F_ASTER window or you 

click on the Close option of the File menu of the F_ASTER window.  Be careful not 

to close the window of the main ASTER window, the title bar of which is above the 

F_ASTER window.   
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What does E_ASTER do? 

 

E_ASTER is used to assess the distributional impact of the reform.  What is the 

average gain or loss for all households? Has inequality increased or decreased? Do 

younger households lose more or less than older ones?  

How do I start E_ASTER? 

 

The start of the evaluation program is the same as for the first two parts of the 

program  Click the File option in the menu bar of ASTER and choose Open 

E_ASTER file in the pull down menu.  The standard dialogue box for selecting a file 

appears allowing you to select a file with the options for the evaluation program.  In 

the E_ASTER program you can make many choices: which variable do you want to 

analyse? Do you want to use equivalence scales? Which characteristics do you want 

to use in the distributional analysis? What values do you want to use for the parameter 

of inequality aversion? All these options and settings will be saved into a file with the 

extension .OPT.  The first time you start E_ASTER you find the file 

C:\ASTER\EASTER.OPT which is set up during the installation of the program.  As 

you can also save options you make (see the section ‘How do I quit E_ASTER?’) this 

mechanism relieves you from the tedious task of resetting all these options in a next 

run of E_ASTER.  A warning should be made here.  You can give this file whatever 

name you want as long as it has the extension .OPT but be sure you save it under the 

C:\ASTER directory (or the basic directory if you gave it another name).  If you don’t 

do this you will have to move it back to this directory if you want to use it again in a 

following run of ASTER. 

When you click on the Ok button after selecting the appropriate file you get the 

window presented in figure 24 which allows you to select the different options.  The 

title bar shows the filename you have just chosen in the previous window.   
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How do I set the options for E_ASTER? 

The different options can be selected from within the window which is represented in 

figure 24.  The displayed options are retrieved from the file which is mentioned in the 

title bar. 

 

Figure 24: E_ASTER: Select Options and settings window 

 

The window consist of two parts.  The upper half are global settings for the 

E_ASTER  program.  The second half of the window reveals that the E_ASTER 

program consists of three different parts.  You indicate whether or not you want to 

have a part executed by using the small check boxes at the left.  We now look at the 

different options in detail. 

 

How do I define the Input file for E_ASTER? 

The first line specifies the ‘Input Data Set’.  Here you specify the name of the output 

file of the simulation program (F_ASTER) where you have saved the individual 

information about tax payments and total expenditures in the pre and post reform 

situation.  This is always a file with a .TPO extension.  In this example we will 

analyse the file C:\ASTER\WORK\MY.TPO.  If this is the last generated .TPO file, it 

will already be displayed in the field of the first line.  Another possibility is to choose 
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the file from the dialogue box which is activated by the Change button at the right of 

the line.  This is the standard dialogue box to define directories and/or filename 

extensions.  You can now choose a file from the list and click on the OK button.  This 

not only results in the display of the selected file on the first line of the window, the 

second line will also be changed in such a way that the same subdirectory is chosen as 

the one of the selected input file, with the same file name as the input file and with an  

.OUT extension. 

 

How do I define the Output file for E_ASTER? 

The same procedure applies to the second line: ‘Output Data Set’.  This is the dataset 

where the results of the E_ASTER program which appear on the screen, will be 

saved.  This file is also used to report the results of the E_ASTER program.  We 

choose for the output filename: C:\ASTER\WORK\MY.OUT.  The Change button at 

the right works in the same way as described in the previous paragraph except that a 

warning message is displayed when you select an already existing file.  This is done 

because this file will be overwritten when you run the E_ASTER program.  It  makes 

sense to select an existing file if you want to use that file to show the results of a 

previous run of E_ASTER.  By doing this you should select the output data set not 

directly by using the Change button next to the second line, but by selecting the right 

.OPT-file in the start of the E_ASTER program. 

 

Which variable is analysed in E_ASTER? 

E_ASTER calculates gains or losses for different subgroups, or compares inequality 

within the population covered by the sample between pre and post reform situation.  

The variable for which these differences or inequality is calculated is specified in the 

next line.  But other choices are possible.  You find them in Figure 25 which 

represents the dialogue box that appears if you click on the Change button at the right 

of the line. 
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Figure 25: E_ASTER: Select the variable to analyse 

 

There are 12 possible choices: four expenditure concepts and eight tax concepts, 

among which are four tax rates.  If you select a tax rate, and only then, a new window 

will appear to select the denominator for the rate.  This window is displayed in 

figure 26. 

 

 

Figure 26: E_ASTER: Select denominator of tax rate to analyse 

 

As you can see in figure 26 you can select a different denominator for pre- and post 

reform tax rates.   
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At the bottom of the dialogue box with the 12 variables (figure 25) there is a check 

box by which you indicate whether the variable should be corrected by an 

equivalence scale.  You select this correction by clicking on the check box.  If you 

have activated the option there is a mark in the check box.  You can reset the option 

by clicking again on the check box.  You close this dialogue box by clicking on the 

button at the bottom: Select. 

How do I select a welfare concept in E_ASTER? 

The next line in the upper part of the selection window of E_ASTER (Figure 24) is 

called ‘Welfare Concept’.  In some parts of the program the households will be 

ordered from poor to rich.  This line determines on which variable this ordering 

should be based.  Click on the Change button and you get the dialogue box of Figure 

27.  It is very similar to the previous one but only presents the four expenditure 

concepts now.  Again you can choose to use an equivalence scale or not.  We propose 

to construct the welfare distribution on the basis of Net Expenditures.  Therefore we 

click on the third line.  We also want to correct the concept with an equivalence scale 

and click on the check box for equivalence scale use.  Note that this choice to use an 

equivalence scale is independent from the one made in the previous paragraph.  Click 

on Select to leave this dialogue box. 

 

   

 

 

 

 

 

 

Figure 27: E_ASTER: Select the welfare concept 

 

 



     p

How do I start E_ASTER?    

44

How do I choose equivalence scales in E_ASTER? 

The fifth line in the main selection window of E_ASTER (figure 24) is intended to let 

you specify which ‘equivalence scale’ should be used.  This specification is irrelevant 

if you have specified above not to use an equivalence scale.  Moreover there is no 

choice for the moment.  At the current stage of development of ASTER it is only 

possible to use the equivalence scale which is in the original data of the National 

Statistical Institute.  This is the equivalence scale based on old research at the League 

of Nations.  We hope to present more flexibility in the future. 

 

Does E_ASTER always use weighting factors? 

The last global setting in the main selection window of E_ASTER (figure 24) 

concerns the choice whether you want to use the weighting-factors to make the 

sample representative for the Belgium population.  The weighting factors which are 

available are the original weighting factors, constructed by the National Statistical 

Institute.  You can change the option by clicking on the Change button at the right.  

The dialogue box gives two possibilities: used or not used.  If you select not used, 

then each household gets a weight equal to one in the calculations.  The normal 

practice will be to use the weighting factors. 

 

Which part of the E_ASTER module is executed? 

The second part of the main window (Requested Analysis) allows you to choose 

which part of the program has to be executed.  This is useful since some parts may 

require much time (e.g. part 2 and 3 if you request an analysis for many 

characteristics).  You select this part of the program by clicking on the check box at 

the left or by clicking on the Select button at the right of the appropriate line in this 

bottom part of the main selection window of E_ASTER.  If you have selected this 

part of the program then you can also use the Specify... button at the right to set 

further options. 
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The first part of the program produces summary statistics and inequality indices.  For 

the variable specified above you get mean, minimum, maximum, median, standard 

deviation, and some other statistical measures for both the pre and post reform 

situation.  The same statistical measures are calculated for the absolute and relative 

change between pre and post reform situation.  The calculations are based on the 

absolute and relative change for individual households. 

 

If you have clicked on the Specify... button of this first part you get the dialogue box 

of Figure 28.  The way it works is basically the same as previous dialogue boxes with 

check boxes.  You can activate three subprograms in part 1: the overall statistical 

measures, the inequality indices and the measure of distributional change. 

 

 

 

Figure 28: E_ASTER: dialogue box of part 1 

   

The part Descriptive Statistics can only be selected or deselected.  For the second and 

the third subprogram you can also change parameter values.  Take the case of the 

Atkinson inequality measure.  People familiar with this type of inequality 

measurement know that one has to specify an inequality aversion parameter.  You can 

specify three values for this parameter by clicking on the Specify... button at the right  

You now get a dialogue box (Figure 29) in which you can enter or change three 

values.  The same procedure applies to set the value of the parameter in the inequality 

measure of Kolm and Cowell and in the measure of distributional change (See 
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Figure 29).  Be aware that the calculation of the measure of distributional change 

takes quite  a bit of time.   

 

 

  Figure 29: Dialogue Windows for setting the parameters of resp. the 

Atkinson, Kolm and Cowell formulas. 

 

We close the dialogue box of part 1 by clicking on the Accept button at the bottom 

and are again in the main dialogue box of the E_ASTER program. 

 

 

Figure 30: E_ASTER: dialogue box of part 2 
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You activate part 2, the Analysis by Characteristics, by clicking on the check box at 

the left of the last but one line of the main selection Window of E_ASTER (Figure 

24).  Click on the Specify... button at the right and you obtain the dialogue box of 

Figure 30. 

 

How do I analyse the effects for subgroups? 

The purpose of the analysis by characteristic is to calculate gains and losses of the 

reform for subgroups in the population.  The subgroups are specified on the basis of 

characteristics available in the budget survey.  You can e.g. be interested whether the 

loss is greater for older than for younger households.  You therefore need the 

characteristic ‘leeftijdsklasse (age class)’.  There are 62 characteristics available and 

they are listed at the bottom of the dialogue box.  Their numbering corresponds to the 

list in annex 1.  To select a characteristic (take the case of ‘leeftijdsklasse’) you click 

on the appropriate line and then on the great black arrow pointing upside.  The 

selected characteristic jumps to the upper part of the dialogue box and joins the group 

of the Selected Characteristics.  You can repeat this operation for any other 

characteristic.  If you want to deselect a characteristic, select it in the upper part of the 

dialogue box and click on the left arrow which points downwards. 

 

There is one characteristic which deserves a bit more attention.  It is the first one, 

labelled ‘welvaartsverdeling (welfare distribution)’.  It has no number since it is not a 

characteristic from the original dataset but it is calculated by the program on the basis 

of the variable you have specified above.  The best known welfare distribution is the 

one which partitions the population in deciles.  If the household belongs to the bottom 

decile, the characteristic takes the value 1, if the household belongs to the top decile 

the characteristic takes the value 10.  But E_ASTER also allows to choose a different 

quantile distribution than the one in deciles.  If you have selected the characteristic 

‘welvaartsverdeling’, you get a dialogue box which allows you to specify the number 

of groups in which the population has to be divided.  You can choose between the 

values 2 (subgroups with 50% of the population each), 4 (subgroups of 25% or 

quartiles), 5 (subgroups of 20% or quintiles), 10 (subgroups of 10% or deciles) and 20 

(subgroups of 5%).  This dialogue box is shown in figure 31. 
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Figure 31: Window to select the number of groups for ‘welvaartsverdeling’ 

 

If the characteristic has been selected before and you want to change the number of 

groups, you activate the characteristic by clicking it in the upper part.  The button 

Specify... in the middle, between the two selection arrows, has become active now.  

Click on the button and you get the dialogue box described above and shown in 

Figure 31. 

 

Click on the Accept button at the bottom to close this dialogue box.  You are again in 

the main selection window of E_ASTER where eventually you still have to specify 

the options for part 3. 

 

How do I analyse characteristics of gainers and losers? 

Click on the Specify... button of part 3 and you get the dialogue box of Figure 32.  It 

is very similar to the one of part 2 and it also works in the same way.  In part 3 

E_ASTER calculates the average value of the characteristic for a partition of the 

population in subgroups of gainers and losers.  It is the reverse picture of part 2.  The 

main part of the screen is set up to select the characteristics as in the previous part.  

Note that in part 3 the total number of characteristics available is different from that 

in part 2.  The reason is that in part 2 it makes no sense to use continuous variables, 

like age, while in part 3 it makes no sense to use non-ordered discrete variables like 

Social Satus. 
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Figure 32: E_ASTER: dialogue box of part 3 

The top of the dialogue box is different from the one for part 2.  In the first line you 

determine whether the ordering from the greatest loser to the greatest gainer has to be 

based upon the absolute or percentage loss.  You switch between the two options by 

clicking on the Change button at the right.  The second line determines how to 

partition the ordered population.  In this box only the option quantiles is available.  To 

determine the number of quantiles you click on the Change button.  Then click on the 

Select button at the bottom and you get the dialogue box to specify the number of 

quantiles. 

We are back in the window where we can select the characteristics.  Click on the 

Accept button at the bottom to return to the main window of E_ASTER. 
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How do I run E_ASTER? 

 

After you made the appropriate selection you are ready for the execution of the 

evaluation program.  Click on Run! in the menu bar and the E_ASTER program starts 

running.  This means that a Fortran program has started that does the calculations.  

For the whole sample of 3235 households, the calculations of E_ASTER may require 

some time.  Information about the status of the program is written to a new window in 

the middle of your screen. 

 

 

Figure 33: E_ASTER: Output of the Fortran program during the run 

 

Such an output is displayed in figure 33.  As you notice the program sends a message 

to the screen when every part of the evaluation program starts and stops.  During the 

second and third part it also shows when the calculations of a characteristic have 

finished. When the whole program has finished the message ‘E_ASTER has finished’ 

comes on the screen, as well as the start and stop times.  Then a window as shown in 
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figure 34 comes on the screen informing you on the outcome of the program.  An exit 

code 0 means that everything went well. 

 

    

Figure 34: End of E_ASTER Run 

 

This window can be closed by clicking on the Yes button.  You then will be back in 

the main E_ASTER window.  If you don’t click on the Yes button of the window that 

is displayed in figure 34, but on the No button you can scroll in the window that 

shows the statuts of the run.  When you then close this window in the normal way you 

will be back in E_ASTER. 

 

How do I view the reports of E_ASTER? 

 

Clicking on Report in the menu bar of the E_ASTER program reveals a dialogue 

window like the one in figure 35.  In this window you can select the different reports 

of E_ASTER.  One report shows the different options and files that were used in the 

evaluation program and the preceding F_ASTER run.  It can be obtained by selecting 

the option button on the left of ‘Shows settings used during the evaluation and files 

used’ in the upper window of the report dialogue box.  This report is quite similar as 

the summary report of the results of F_ASTER as is shown in figure 22.   

 

The other reports of E_ASTER correspond to the three parts of the program we 

already explained in the preceding paragraph on setting the options: Part 1 gives a 

summary of different statistical measures, Part 2 shows the results of the analysis of 

the selected characteristics while Part 3 shows information about the gainers and 

losers on the selected characteristics. 
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The results of part 1 can be seen in three different tables.  If you click on the Show 

button at the bottom of the screen after selecting the option on the left of ‘Table 1: 

Description of the distribution’ of ‘Part 1’ various measures like the mean, median, 

standard deviation, etc. are shown, as well as the absolute and proportional number of 

winners and losers.  An example of such a report is given in figure 36.   

 

 

Figure 35: E_ASTER: Report Window 

 

The second summary report of E_ASTER informs on some inequality indices.  It is 

generated when the option on the left of ‘Table 2: Inequality Indices’ of ‘Part 1’ is 

selected.  The results for Cowells measure of distributional change will pop up if one 

selects the button on the left of Table3: Measure of Distributional Change  

 

The reports of Part 2 and Part 3 all show information for one characteristic.  You first 

have to select the characteristic in the drop down list box in the right half of the 

screen.  When you click on the down-arrow to the right of these lists the available 

characteristic are shown.  It is obvious that only the characteristics are shown that 

were selected before the evaluation run. 
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After you have selected a characteristic you can see different tables and graphs for the 

selected characteristic.   

 

 

 Figure 36: E_ASTER: Report on the Description of the distribution 
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How do I quit E_ASTER? 

 

The E_ASTER module is closed in the same way as the other two modules are closed: 

you can double click at the upper left corner of the E_ASTER window or you click on 

the Close option of the File menu of the E_ASTER window.  Be careful not to close 

the window of the main ASTER window, the title bar of which is above the 

E_ASTER window.   
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How do I select a file in ASTER? 

 

The dialogue box you can see in Figure 37 can be obtained everywhere in the 

program where you have to select or to define a file name.  The currently selected or 

defined filename is in the one line box at the upper left part of the dialogue box.  In 

the right part of the dialogue box you can redefine the drive and the directory for 

which filenames have to be displayed.  You can enter or select any other file name in 

the appropriate field at the upper left corner of the window.  We suggest you use the 

same name for all files of one run through the different modules of this program.  It is 

also recommended to keep all generated files of such a run in the same directory.  By 

installation the C:\ASTER\WORK directory will be created for your first run.  If you 

plan to store your data on other directories then you should create these directories 

before you run the ASTER program as it is only possible to select an existing 

directory.  You cannot create a new directory from within this dialogue box.   

 

 

Figure 37: The standard dialogue box for selecting a file 
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How do I make a Report in Text mode in ASTER? 

 

ASTER presents reports in two ways: In text mode, which means that results are 

presented in tables, or with graphs.  In this paragraph we explain the first possibility.   

 

When you are on a screen that reports in text mode there is always a File option in the 

Menubar.  When you select this option you can then choose to click on either Print 

Topic to print out the information displayed or on Edit Titles to edit the titles and the 

footnote that are printed on the page with the results. 

 

 

Figure 38: Title Editing Window for printing tables in ASTER. 

 

By clicking on the Edit Titles option of the File menu a window as shown in figure 38 

appears.  The first line is always the same as the title of the report that is shown.  It 

can be changed however using the normal editing functions.  It remains until a new 

report is generated.  The undertitle and the footnote on the other hand remain the 

same as long as you run the program.  Both are blank when the program is started up.  

When filled in, the undertitle appears as the second line on the printed page while the 

footnote is at the bottom of the printed page.  It is obvious that you first have to edit 

these lines before you select the Print Topic option if you want to print out the 

textlines you entered. 

The Print Options option can be used if you want to change the printer settings of the 

printer.  It generates the normal Windows-dependent printer driver options as you get 

in other Window programs.  One of the options e.g. is to select a landscape 

orientation instead of the default portrait orientation. 
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How do I make a report in Graphical mode in ASTER? 

 

When you have chosen to view information in a graphical way, by default a three-

dimensional bar diagram with vertical bars is displayed.  This is shown in Figure 39. 

 

 

Figure 39: Example of a Graphtype: 3D-Bar Diagram. 

 

It is possible to change the type of graph by choosing one of the many options of the 

Graph Type menu.  There are 2D- and 3D-Bar Diagrams, 2D- and 3D-Pie Charts; 

Gants-, Line- and Log/lin Graphs; Area, Scatter, Polar and HLC Graphs.  Furthermore 

for each kind of mentioned graphs some options are available to select e.g. 

orientation, the way of labelling, used symbols and so on. 

Depending on the nature of the displayed data not all options make sense.   

Another option that can be chosen by clicking on Gridstyle is the appearance of 

vertical and/or horizontal lines. 

All graphs (or combinations of grahtypes and gridstyles) can be printed by clicking 

the Print option on the File menu. 
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ANNEX 1: LIST OF AVAILABLE CHARACTERISTICS 

 

35. DECIELNR. NOMINALE BESTEDINGEN PER VERBR. 

36. DECIELNR. NETTO BESTEDINGEN 

37. DECIELNR. NETTO BESTEDINGEN PER VERBR. 

38. DECIELNR. BESCHIKBAAR INKOMEN 

39. DECIELNR. BESCHIKBAAR INKOMEN  PER VERBR. 

40. SOORT HOOFDVERWARMING 

41. ENERGIEBRON HOOFDVERWARMING 

42. BIJVERWARMING? 

43. ENERGIEBRON BIJVERWARMING 

44. GEWEST 

45. PROVINCIE 

46. STROMEND WATER? 

47. STROMEND WARM WATER? 

48. BADKAMER? 

49. WC BINNEN WONING? 

50. TELEFOON? 

51. GARAGE? 

52. AANTAL AUTO"S 

53. DUMMY VOOR AUTO 

54. AANTAL CARAVANS 

55. AANTAL MOTORFIETSEN 

56. AANTAL ZWART-WIT TV"S 

57. AANTAL KLEUREN TV"S 

58. AANTAL VIDEORECORDERS 

59. AANTAL HUISCOMPUTERS 

60. AANTAL KOOKHAARDEN ELECTRISCH 

61. AANTAL KOOKHAARDEN BUT-PROPAAN 

62. AANTAL KOOKHAARDEN AARDGAS 

63. AANTAL KOELKASTEN 

64. AANTAL DIEPVRIEZER 

65. AANTAL VAATWASMACHINE 

66. AANTAL ELECTRISCHE NAAIMACHINE 

67. AANTAL WASMACHINE 

68. DUMMY VOOR ROKERS 

 

    WELFARE 

3.  LEEFTIJD GEZINSHOOFD 

4.  LEEFTIJDSKLASSE GEZINSHOOFD 

5.  NATIONALITEIT GEZINSHOOFD 

6.  SOCIAAL STATUUT GEZINSHOOFD 

7.  SOCIAAL STATUUT PARTNER 

8.  SOCIAAL STATUUT GEZIN 

9.  DUMMY VOOR WHITE COLLAR GEZIN 

10. DIPLOMA GEZINSHOOFD 

11. DIPLOMA PARTNER 

12. DUMMY HOOG DIPLOMA GEZIN 

13. NIS-TYPOLOGIE GEMEENTE 

14. EEG-TYPOLOGIE GEMEENTE 

15. AANTAL KINDEREN (PRO RATA TEMP) 

16. AANTAL PERSONEN (PRO RATA TEMP) 

17. AANTAL VERBRUIKSEENHEDEN 

(VOLKERENB) 

18. AANTAL PERSONEN IN HET HUISHOUDEN 

19. AANTAL KINDEREN JONGER DAN 6 

20. AANTAL KINDEREN TUSSEN 6 EN 11 

21. AANTAL KINDEREN TUSSEN 12 EN 15 

22. AANTAL KINDEREN TUSSEN 16 EN 24 

23. AANTAL KINDEREN TEN LASTE 

24. EEG-TYPE GEZIN 

25. REFERENTIEPERSOON ACTIEF? 

26. PARTNER ACTIEF? 

27. AANTAL KINDEREN ACTIEF 

28. AANTAL ANDEREN ACTIEF 

29. TOTAAL AANTAL ACTIEVEN 

30. WOONSTATUUT 

31. EIGENAAR TWEEDE VERBLIJF? 

32. SOORT WONING 

33. BOUWJAAR WONING 

34. DECIELNR. NOMINALE BESTEDINGEN 



ASTER 3.0: WAT IS ER VERANDERD T.O.V. VERSIE 2.0? 
André Decoster, Guy Van Camp en Frederic Vermeulen – 23 Februari 2001 

 

Voor Aster2.0 werd een handleiding geschreven, die u of in gedrukte vorm of in de vorm van 
een MS-Word document ontvangen hebt. Deze handleiding kan, in grote mate, nog steeds 
gebruikt worden voor Aster3.0. Toch is het nodig om bij sommige secties in de handleiding van 
Aster2.0 kanttekeningen te maken. Daarom hebben we in wat volgt de inhoudstafel van deze 
handleiding overgenomen. Indien nodig wordt onder een bepaalde sectietitel de nodige uitleg 
gegeven om het verschil tussen Aster2.0 en Aster3.0 te verduidelijken. 

Zoals u zal merken zijn de schermen zelf nauwelijks veranderd, de belangrijkste verschillen 
tussen Aster2.0 en Aster3.0 hebben te maken met de onderliggende data en het gebruikte 
vraagsysteem. In Aster2.0 werd gewerkt met de Budgetenquête van 1987-88 en werd een 
vraagsysteem van 32 goederen gebruikt. In Aster3.0 wordt de Budgetenquête van 1997-98 
gebruikt en kan men slechts voorspellen met een vraagsysteem van 12 goederen. 
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Welvaartsconcept 
3.  Leeftijd gezinshoofd 
4. Leeftijdsklasse gezinshoofd 
5. Sociaal statuut gezinshoofd 
6. Diploma gezinshoofd 
7. Aantal volwassenen 
8. Gemiddelde leeftijd volwassenen 
9. Aantal kinderen 13-17 
10. Aantal kinderen 7-12 
11. Aantal kinderen 0-6 
12. Aantal personen 
13. Aantal verbruikseenheden (oeso-schaal) 
14. Typologie gemeente 
15. Eeg-type gezin 
16. Referentiepersoon actief? 
17. Partner actief? 
18. Totaal aantal actieven 
19. Woonstatuut 
20. Soort woning 
21. Geschatte huurwaarde 
22. Enegiebron verwarming 
23. Decielnr. Nominale bestedingen 
24. Decielnr. Nominale bestedingen per verbr. 
25. Decielnr. Beschikbaar inkomen 
26. Decielnr. Beschikbaar inkomen per verbr. 
27. Gewest 
28. Provincie 
29. Aantal auto"s 
30. Dummy voor auto 
31. Dummy voor rokers 
32. Inkomen gezin 
33. Hoe komt u rond met uw inkomen? 
34. Soms moeite om voedingswaren te betalen? 
35. Soms moeite om kleding te betalen? 
36. Soms moeite om verwarming te betalen? 
37. Soms moeite om dokters enz. Te betalen? 
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